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LESSON 1 - WORK PACKAGING
OVERVIEW

Lesson Duration: 45 minutes

Lesson Objectives
After completing this lesson, you will be able to:

e Describe the two modules of Plan

e Explain the high-level work flow of Plan — Work Packaging

Lesson Topics

1.1 Plan Work Packaging OVerview ... . .. .. 10
1.1.1 InEight Plan Work FIoW 10
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1.1 PLAN WORK PACKAGING OVERVIEW

InEight Plan is an application within the InEight portfolio of products. It is a tool for engineers and
superintendents to plan their work and track quantities during the construction of the project.

InEight Plan is organized into two modules:

Plan Modules

Work Packaging  Creating and managing work packages.

Quantity Tracking Creating and managing components and claiming schemes.
Claiming completed quantities.

1.1.1 InEight Plan Work Flow

The below workflow illustrates the functions of both InEight Plan and InEight Progress, and how data
flows between the two applications.
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Scenario

You are a Project Manager about to start construction of a Steel Structure project. Your first step
before starting construction is to break the project down into pieces that are more manageable.

e L North Area

Sempa-
[
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0103 [05107]09 1113 [15|17 19 21]23]25 27 29|

[EleE el EE[msED =] = e]E=] =]

South Area

The image below depicts a layout for a steel structure project. The project consists of erecting 30
separate steel structures on opposite sides of a road. Each structure or module has been assigned a
number 1-30.
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e

w
Structore 1

1.1.2 Work Packaging

Work Packaging breaks down projects into small, manageable scopes of work so that operations can be
assigned to responsible supervision, executed, and tracked effectively. In InEight Plan, you can break
the work of your project into construction work areas (CWAs), construction work packages (CWPs) and

installation work packages (IWPs).
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Work Work Work Work Work Work Work Work Work
Package Package Package Package Package Package Package Package Package

As mentioned in the scenario above, the scope of the Steel Structure project was too big to manage

without segmenting it down to work packages representing one to four weeks’ worth of work. In Plan,
this breakdown of the project could look like this:

Project Steel Structure project

CWA North Area South Area

Steel
Erection

CWP i Foundation

Foundation

Erection

Steel Erection Steel Erection Steel Erection

WP Steel Erection Steel Erection Steel Erection
Module 02 Module 04 Module 06

Module 01 Module 03 Module 05

1.1.2.1 Work Package Details

Work package details include the following information:

e Work sequence

e Budget
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Resources required

Constraint Management

Components and quantities

Project

Environmental Safety
Work Sequence Components
Budget Quality
Resources

Safety, quality, and environmental concerns

For your Steel Erection work plan, you can create a work package for each module.

Project

CWA

Steel Structure project

North Area

South Area

CWP

Steel
Erection

Foundation

Steel

Erection Foundation

IWP Steel Erection

Module 01

Steel Erection
Module 03

Steel Erection Steel Erection
Module 05 Module 02

Steel Erection Steel Erection
Module 04 Module 06
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e =0 In Work Package Management, you will learn about work plans and work packages in
detail, including how to create them and define plan details.

1.1.2.2 Comprehensive Workflow
The diagram below displays both sections of Plan and how they integrate with InEight Progress, InEight
Control and your Payroll system.

You will notice the areas where you create associations between work packages and daily plans, work
packages and components, and components and claiming schemes.

The details of this workflow and the step by step functions within it will be covered in the remaining
lessons of this and the Plan Quantity Tracking module and the Progress module.
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Lesson 1 Review

1. Which two of the following are modules in Plan?
a. Quantity tracking
. Benchmarking
. Work packaging

b
Cc
d. Control
€. Reporting
f.

Daily planning

2. Which one of the following represents the order for breaking down your project scope
from larger to smaller pieces within InEight Plan?

a. Project > CWA > CWP > IWP
b. CWA > IWP > Project > CWP
C. Project > Work plan > CWA > CWP
d. Project > CWA > IWP > CWP

3. According to the InEight Plan workflow diagram, installation work packages (IWPs)
associate with which of the following? (Select all that apply)

a. Inspections
b. Components

. Web daily planning

c

d. Estimating
€. Mobile daily planning
f

. Payroll

Lesson 1 Summary

As a result of this lesson, you can:

e Describe the two modules of Plan
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« Explain the high-level work flow of Plan - Work Packaging
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LESSON 2 — GENERAL NAVIGATION

Lesson Duration: 30 minutes

Lesson Objectives

After completing this lesson, you will be able to:
o Navigate the InEight Plan Work plans page
e Manage columns
e Manage data blocks

e Create viewsets

Lesson Topics
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2.1.3 Installation Work Packages (IWP)Page ... 26

2.2 COlUMNS 27
2.2.1 Move ColUMNS 27
2.2.2 Sort COlUMNS 27
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2.5.1 Add a Query
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2.1 PAGE NAVIGATION

In this lesson, you will explore the layout and start to navigate around the application.

You access InEight Plan through your web browser. When you first log in, you will land on the All
projects & organizations page within the InEight project platform. Here you can select any your
projects.

@ All projects & organizations v @ ®
PROJECTS ORGANIZATIONS
1D Name Status Organization Created by Created on
= 105091 Steel Structure Job Active $100000 - (PKS Inc) jeremy cheek 06/04/2018 3:30:26 PM -

From the All projects & organizations page, selecting a project navigates you to the home page for that
project. From your project home page, there are two different ways to access the Work Packaging

module of Plan.

Navigate to the Work Plans Module via the Project Home Page

1. From the All projects & organizations page, select your project.

IAY Steel Structure Training Job (105091) - Projecthome v ®@ N ® ®

@ Links [E4 () Control (%) Quantity tracking
Organization Manage budgets and forecasts Build components and document
quantities
InEight University
Launct Launch
a .
Project
InEight University
(#) Work packaging %) Daily planning
Group work into plans and packages Assign tasks for your crew
Laupch Launch
=} Project notes [E4 ®) Contracts (@) Supporting documents
Status Count Pending
Executed 1 1
fod
£} Settings () Bid packages
Project and application settings
w t
anage settings . .
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2. Select the Work Packaging module by clicking on the Work packaging tile on the right or
selecting Work packaging from the side bar menu on the left.

@
@) 105091 (Steel Training Job) ~  Projecthome + ® O e @
+ T3 Project notes © % Control %) Quantity tracking
Addproject mage Manage budgets and forecasts Build components and document quantities
Launch Launch
105091 (steel Training Job) a
Applications - 3) Work packaging %) Daily planning & Links
Model
Document Group work into plans and packages Assign tasks for your crew Organization
In€ighty
Schedul Launch Launch
°
TeStS6TTest567Tests6TTestS6TTests6Tes
Report D Bidpackages B Supporting documents MahendranMahendranMahendranMahendra.
Feport Karthik
Explore TesT124
Dashboard
@ @ Project
APl documenta tion
5 Control 5 Contracts %) Change status %) Prime contract summary
Workspaci Status cout MW Closed [ InPro.. || Active
Project ibrary
Issue 5000
Pla
o o 3 Executed Client CO's 5000
Quantity trackin Potential cient change orders
Adjusted/Current contract 5000
Work packaging
° o o InReview Client CO's 5000
% Progress Client change orders
Deily planning . Projected contract 5000

0 ) 0

Navigate to the Work Plans Module via the Navigation Bar

1. From the Projects page, select the second level drop-down menu, hover over Plan, and then
select Work packaging.
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2] 105091 (Steel Training Job)

+ 7 Quantiy tracking
m () Model Estimate £ () Plan ©) Contract df id dd -
Addprojectimage ts and forecasts Build components and document quantities
g t +) Control ' h Launch
105091 (Steel Training Job) Documen Control Change
2) Schedule
Applcations [ — & Links
Model
Project Extensions r your crew Organization
= Document
Schedule Project home A Design Launch neighty
Project details 0 des
Billing Test567Test567Test567Tests67Tests67Tes.
Report Settings Assigned ope alr Iments MahendranMahendranMahendranMahendra.
Workflows. Assigned disciplines and commodities Karthic

TEST124

Project

Original contract 5000
0 Executed Client CO's 5000
Adjusted/Current contract 5000

InReview Client CO's 50.00
% Progress

Daily planning . Projected contract 5000

Overview - Work Plans/Packages Page

1 First Level Menu Shows the selected project and provides access to favorites, All
projects and organizations, reports, master data libraries, and
suite administration.

2 Second Level Displays the list of applications (Control, Plan, etc.), and
Menu navigates you to other project settings.
3 Third Level Menu  Navigates to individual modules inside each application (e.g.,

Contract > Bid packages, Plan > Quantity tracking). Options in this
menu are dependent upon the application you are currently using.

4 Help Menu Contains Walkthroughs to walk you step by step through
processes within the module.

5 Notifications and  View notifications, user profile and log out.
User Profile

6 AWP Panel Allows you to access work plans (Work Packaging tab) or see
planning progress (Planning Schedule tab).

7 Actions Menu Select available actions for the current register tab you are
viewing.
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Overview - Work Plans/Packages Page (continued)

8 Toolbar Contains functions for the page you are on: add, edit, delete,
export, import, show details, and search.

9 Block View View the Work Plans/Work packaging page in a card view layout,
the page displays the most recent saved work package, as well as
a card for each work package associated with the CWA or CWP in
the same order and data as the default grid view.

10 Column Chooser  Allows you to add or hide columns to make the plans/packages
list user specific.

11 Query builder Lets you add, edit, delete, copy, and share queries to search for
work areas and packages.

12 Work List of all work plans and packages in your project.
Plans/Packages
Register

Overview - Area/Construction/Installation Work Packages Pages

1 Breadcrumbs  Navigational links that allow you to track your path from the page you
are currently viewing back to the work plans/packages page.
Furthermore, identifies what and where you are within a work package.

2 Tabs Navigate between different functions on a page. The blue line indicates
what tab you are currently on.

3  Toolbar Contains functions for the page you are on: add, edit, delete, export,
import, show details, and search.

4 Block View View the Work packages page in a card view layout, the page displays
the most recent saved work package, as well as a card for each work
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Overview - Area/Construction/Installation Work Packages Pages (continued)

package associated with the CWA or CWP in the same order and data
as the default grid view.

Not pictured: When in block view, you can use a toggle to switch
between viewing calculations in Cost % Complete and Mhr %
Complete.

5 Column Add or hide columns to make the plans/packages list user specific.
Chooser

6 Side Panel Contains a brief summary of your CWA, CWP, or IWP, fed from their
overview and workspace tabs as well as associated components.
Percent complete charts are shown for man-hours and cost in dollars.

2.1.1 Construction Work Areas (CWA) Page

26

Description Schedule ID Start date End date Total man hours Mhr%comp  Cost%comp Status Created by Last updated on

nnnnnnnnnnn » [ CWP-North Area Steel Er. 7 Work package for structural s 08/03/2020 08/14/2020 0 000% 000% Draft Neil Stein 08/03/2020

M % Complete

0%

Cost% Complete

0%
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2.1.2 Construction Work Packages (CWP) Page

Work Packages

Iwolkpzckegmg > North > cwwmnmsmlamo

Plan User Guide

‘CONSTRUCTION WORK
CWP-North Area Steel Erection
i
Number Q
7 O Workpackage name o Description schedule D statdate end date Total man hours Mhrxcomp  Costkcomp  Stats Createdby Lastupdated on @
Descripion
Work package for structural steel O 5 IWP-Steel Erection - Module . 8 Steel erection of Module 0. 08/03/2020 08/07/2020 o 000% 000% Draft Neil Stein 08/03/2020 -
M % Complete 0
Cost % Complete
Schedule D
Start dae: August 3,2020
End date: August 14,2020
Status: Draft
Supeintendent
Field Engineer
Plamner
Total man hours: 0
°
2.1.3 Installation Work Packages (|WP) Page
Workpackaging > North > CWP-North Area Steel Erection | > IWP-Steel Erection - Module
Work Packages
Name
IWP-Steel Erection - Module 001
Number o
s .
Descrition Overview
] f Module 001
WP D IWP name cwp cwa
Mhr % Complete
8 IWE-Steel Erection - Module 001 CWP-North Area Steel Erection North-North v
Description
Steel erection of Module 001
Cost % Complete Scope of work
Location Discipline Type of work Risk
Metals v Steel Erection Medium v
Schedule D Schedule ID Schedule name Scheduled start date Scheduled end date
start dae: August 32020
end date: August 7, 2020 Mon, 3 Aug 2020 B Fi7aug200 &
Staus: Draft
Planner Status Last updated by Last updated on
Superintendent Sers/2020
Field Engineer: Draft M 200
Erccutor
[Total man hours: o

TIP

The Construction Work Packages/Work Packages tab displays all the work plans that
you have created or are assigned to as the Superintendent, Engineer, or Foreman.
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2.2 COLUMNS

Customize columns according to your preferences from the Work plans/packages page. Changes you
make to the placement of your columns will be retained the next time you access any page you have
customized.

2.2.1 Move Columns

Drag and drop to move a column from one place to another to customize your view.

Move Columns

1. On the Work plans/packages page, click on and hold a column header.

] Steel Training Job (105091) - Plan v Work packaging +
‘Work plans
Actions w @
¥ Work package name D Schedule ID Start date End date
[ North North
0 South South

~ [0 Unassociated pac..

2. Drag and drop the column in a new location.

Steel Training Job (105091) lan Work packaging ¥

Work plans

actions v (¥)

¥ Work package name

D - Descnphorl-—-:  Schedule ID Start date End date
3 North North M

3 South South

@ w [3 Unassociated packages

2.2.2 Sort Columns

Sort in ascending or descending (both for alpha and numeric fields) order on any column by clicking
one time on the column header.
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Sort Columns

1. On the Work plans/packages page, click on any column header to sort the column in ascending
order.

e Notice the yellow “up arrow" designating you are sorting in ascending order

Description Schedule ID Start d@ End date

2. Click on a column header again (a second time) and the column will filter in descending order.

» Notice the yellow arrow is now pointing down

2.2.3 Filter Columns

Filter columns as a way to see relevant information pertaining to your specific needs.

Filter Columns

1. On the Work plans page, click the filter pyramid of any column header.

2. In the resulting drop-down list, select an operator.
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Scheduled start = Scheduled finish

06/1%  show items with value that:

06/11 Is equal to -

06/1! Is equal to

Is not equal to

Is after or equal to
Is after

Is before or equal to

Is Before

3. In the first search box, enter a date.

Scheduled start = Scheduled finish

06/18/2018  ghow items with value that:

06/18/2018 'S equalto .
06/18/2018 m
And -
Is equal to -
&1

4. Click Filter.
e The table now only shows items that qualify for your filter

e Notice that the filter pyramid is now in yellow indicating that this column is filtered
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@) Steel Structure Job (105091) - Plan v Work packaging v ©) ®
Work plans < MY WORK PLANS ALL
actions = (®) O™ 0O Q

¥ ID Description Name Scheduled start D Scheduled finish

v B 4972 Work plan for the structural steel of the North area North Area Steel Erection Work Plan - 001 06/18/2018 06/29/2018

v B 399% South Area Steel Erection Work Plan -001 06/18/2018 06/29/2018

i 4758 Structural Steel Mobilization 06/18/2018 06/19/2018

5. Select the filter pyramid again.

Scheduled start = Scheduled finish
06/18/2018  ghow items with value that:
06/18/2018 'S equalto
06/18/2018 6/18/2018 m
And -
Is equal to

|

Clear

TIP

Hover over Filter, then click Clear to remove your filter.

Apply multiple rules to your filter. For example, setting a “Contains” or “Is equal

to” filter for your column would allow you to bring in two distinct results at once.
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Exercise 2.1 — Filter Columns

In this exercise, you will practice filtering columns from the All tab on the Work plans page.

1. Find a discipline by using the column sort function.
2. Remove the columns you do not need in your view.

3. Apply a filter you would use to make the data more relevant.

Congratulations, you have completed this exercise!
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2.3 DATA BLOCKS

On the Workspace tab of an opened installation work package, the work package details are contained
within data blocks. Each data block is a set of columns grouped together based on categories of
information. Data blocks help you to organize and manage all the columns on a page.

Data blocks are customizable, and can be viewed moved up or down in the register. Sort and filter data
block information to organize your view. The information in each data block is displayed in a grid like
format, maintaining a spreadsheet look and feel.

@
@ 105091 (Steel Training Job) - Plan ~ Work packaging ~ @ o 0 ®
Workpackaging > North > CWP- North Area Steel Erection... > IWP- Steel Erection - Module 0...
| Work Packages
OVERVIEW WORKSPACE CONSTRAINT MANAGEMENT DOGUMENTS View:  Work Packaging -

IWP- Steel Erection

90984 Components . a @ Add components by WBs
Steel erection of Module 001

Component ID Description Quantity UoM wes
Manage workspace x Module 01 - A6 C Module 1 -A6 @ ! e 0 0 Metals e -
| X Module 01 - A7 Conn: U Module 1 - A7 Connect 1 Ea o o Metals S
CERES X Module 03 - AG Conn u. Module 3 - AG Connect 1 & 3 o Metals o
¥l Budget
@ Components S u_ Module 3 AT Con ! & 0 0 Metals )
Lessons learned
quality forms. ) § u. Module 5 - AG Connect 1 =) 0 0 Metals S

@ Work sequence
Tools
Temporary structures

@ Labor
Goals

Work sequence . ar (@ Add work step
Work step number  Description Attachments  Hold paint Man hours Schedule start Schedule finish
X 1 0ff load steel ® -
X 2 nstall steel ‘ =0 ®
X 3 Bolt and torque ‘ =8 Y ®
X 4 Quality inspection ‘ ®
X s Tun ‘ = ®

2.3.1 Add Data Blocks

Add Data Blocks

1. From the Work plans/packages page, select a hyperlink under the ID Column for an installation
work package (IWP).
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@ 105091 (Steel Training Job) Work packaging ~

Work packaging > North

Work Packages
North (] % Work package name D
North (] A~ [E CWP- North Area Steel Ere 90982

5 IWP- Steel Erection - ..

IWP- Steel Erection - Module D01

2. Once you are in an individual work plan, select the Workspace tab.

3. From the Manage workspace slide out panel on the left, select data blocks to include in your

workspace.
@ Steel Training Job (105091) v
Work packaging > Meor

I Work packages

IWP- Steel Erection ...

e Work sequence
Steel erection of Module 001

Work step..  Description

Manage workspace

[ Equipment

L) Materials

|| Budget

[ Components.

LI Constraint management
) Lessons learned

) Quality forms

I [#| Work sequence I

[ Tools

| Temporary structures
) Labor

[ Goals

[ Quality

[#| safety

() Environmental

Save workspace as view
St Safety

Meyg= Scroll up and down between the data blocks to view all your data blocks.
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2.3.2 Navigate Data Blocks

Use the arrows at the top of your data block to view more columns associated with each data block
that are not in the current pane.

Work sequence B Planning complete (®) Add work step

The number of dots between the arrows represent how many panes are in that data block.

2.3.3 Manage Data Blocks

2.3.3.1 Context Menu

The Context Menu allows you to customize the order of columns in each data block. You can also use
the Context Menu to add or remove columns from a data block.

Work sequence {e > B Planning complete () Add work step =

Use the Context Menu

1. On your data block, click on the Context Menu icon.

2. Select Choose columns from the drop-down menu.

Quality () Add quality step

W Planning completa

.
H
H
Choose columns

Pop out to new windo.

Close

3. On the resulting slide out panel, search by name or category for a column. Then, select your
column from the list and click on the right arrow to add that column to your data block on the
right.
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@ 105091 (Steel Training Job) - Plan + Work packaging ~
Work packaging > Morth > CWP- North Area Steel Erection... > IWP- Steel Erection - Module 0...
I Work Packages
OVERVIEW WORKSPACE CONSTRAINT MANAGEMENT DOCUMENTS
Data hlock: choose columns
hold
ALPHABETICAL BY CATEGORY Panel 1
(o wd
Hold point .
P I (click to change)
@ Inspector Mitigation Type of ins... Quality risk Spec I&TP Tolerances
=3

TIP You can also drag and drop columns into your data block. Once in your data block,

you can reorder columns by dragging and dropping.

4. Repeat step three as needed. When finished, click Done.

Each type of data block has its own unique default settings. Default settings include

NOTE

2.3.3.2 Resource Button

specific locked columns and total number of columns and panels.

Uniquely named for each data block, the Resource Button allows you to add information or resources
to your data block.

Quality e o > M Planning complete (® Add quality step

2.3.3.3 Daily Plan Icon

The Daily Plan icon is a shortcut that allows you to create daily plans directly from an IWP by selecting
which details to include in a daily plan.
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Step Description Hold point

1 Torgue Inspection Yes

Mew guality item 3

= N e
-k FE|LE

3 Mew quality item 2

Clicking on this icon will open a slide out panel to the right where you can view the items you've
selected to include in your daily plan and continue onto the creation window.

Workpackaging > North | > CWP- North Area Steel Erection.. >  IWP- Steel Erection - Module 0... . X
Create daily plan
'WORKSPACE 3
Labor
Quality . W Planning complete Equipment
Step Description Hold point Quality risk Mitigation Type of inspection = Inspector Spec

b § M 2 New quality item 3

b § M s New quality item 2
Quality
Torque Inspection S}
Safety

Environmental

M Planning complete

Step Description Safety risk Mitigation Required safety ite
I M Crush points -
b § M 2 Watch for falling objects N
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Create daily work plan

o Plan details

= Plan date * Plan name
shift Work plan/package ID - Name Planner notes
First Shift - 90984 - IWP- Steel Erection - Module
ool
Location

Approvers (1 Required)

Executors (0 Required)

Add and Manage Data Block Contents

1. On your data block, click on the Resource button to add an item.

Quality . lanning complete @ Add quality step

Step Description Hold point Quality isk Mitigation Type of inspection Spec 18TP

New quality item 3 -

‘ Torque Inspection Ves

H W E
FECECE
®®®

‘ New quality item 2

2. Rename your items by clicking on the item Description cell and entering a new name.
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Step Description Hold point Quality risk

MNew quality item 3

iy New quality item 3 Ves

2 New guality item 2

H R .
FE -E EE

3. Reorder your items by click on the item Step cell and adding or changing the order
number.

TIP You can sort and filter your data block columns.

Step Description Hold point
1 m 1 Torgue Inspection Yes
1 m 2 MNew quality item 3
1 m 3 New quality item 2

e =0 Delete an item by selecting it then clicking on the red "x" to the right.
Torgue Inspection Yes
®
®

1

2

New quality item 3

H B
CE FE R

3 New quality item 2

2.3.3.4 Pin lcon

The Pin icon allows to flag critical components that will hold up the start of the operation if not
addressed. When pinned, an item will automatically appear under the Constraint Management tab of
the Work plans/packages page. There, you can review and further manage all pinned items.
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Step Description Mitigation
1 m 1 Torgue Inspection
1 m 2 ‘ New quality item 2

Work sequence . M Planning complete (® Add work step
Work step number Description Attachments Man hours Schedule start Schedule finish
b § 1 Off load steel ® -
I 2 Install steel ‘ ®
I:l 3 Bolt and torque ‘ =0
b § 4 Quality inspection ‘ ®
b § 5 Turnover ‘ ®
« Notice that when you pin an item, the data block row turns blue
ining Job) - Plan + Work packaging + @ O 0 ®
Workpackaging > North > CWP- North Area Steel Erection.. > IWP- Steel Erection - Module 0...
OVERVIEW WORKSPACE CONSTRAINT MANAGEMENT DOCUMENTS
Constraint management W Planning complete (® Add constraints
tem number Description Category Responsibility Due date Status
| o0l Bolt and torque Work Sequence m:] ® | -

TIP To unpin an item, go to the Constraint Management tab, and delete the item. Changing
the status from "open" to "closed" will not unpin or remove the item from the
Constraint Management tab.

e = You can also manually add constraints under the Constraint Management tab.

2.3.3.5 Completion Indicator

The Completion Indicator allows you to indicate which data blocks are completely planned.

Quality Co o> M Planning complete (® Add quality step

As you check off data blocks, you can track your planning progress from the Planning Schedule tab on
the AWP panel (Work plans/packages page of Plan Work Packaging).
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2.4 VIEWSETS

You can create a saved view of your page so that you can always revert to it. This saved view is called a
viewset.

Create a Viewset

1. Select the View drop-down arrow to save your current view.

2. Select Save current viewset as from the viewset drop-down list.

N

View: -

Save current viewset as. ..

Ezname current viewset a...
Delete this viewset

Mew viewset

(*) Add work step

Schedule finish

3. In the dialog box, type a name.
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Save this viewset as:

First Last Preferred View X

Cancel m

4. Click Save.

MeJ =0 Each viewset is user-specific and can be used in any plan.

2.4.1 Send a viewset

Alegpa Certain permissions are needed to send viewsets to roles.

You can send views to all users that have a certain role. You can also send it to specific projects or full
organizations. To send to a project, you must be a user on that project or in that organization.

1. Open the viewset you want to share.
2. Open the View drop-down list, and then select Send current view.

3. Select Users or Projects from the drop-down list, and then type the name of the user or project
to search for it. You can add multiple users and projects.

Meyp=n If you share a view with another project, any project-specific fields are not shown
in the receiving project.
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Send view (test danielle) to

Less il
SEnd 10
Usrrs
Ho users selecled :E—;
Rales

Nip roles sebacted
Prajects h‘
Mo projects selected (=)

Organizations

e
L1

Mo organizations sslecbed

% Rarndii
_:_' EMKaYE A

4. Click Send.

A notification is sent to the selected users and the viewset is available in their drop-down list with the
sender’s name and when the viewset was sent.
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Exercise 2.2 — Create a Viewset

Now that you have learned some of the basics of navigating in InEight Plan, from the Work
plans/packages page, create an installation work package viewset that you would use.

1. Select the data blocks you might need. (e.g., Labor Equip, and Budget).
2. Select the desired columns you want to see in each data block.

3. Save your view.

Congratulations, you have completed this exercise!
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Lesson 2 Review

1. How do you know which project you are working in?
a. Breadcrumbs
b. Navigation bar — First level menu

C. Notifications and User profile

2. You CANNOT sort and filter columns if they are in a data block. Only on a register page.

a. True

b. False

3. From where can you customize the order of columns in each data block?

a. Context menu
b. Customization page
C. Data block navigation

d. Settings menu

4. On the Workspace tab of an installation work package, to save the data blocks you have
selected to display on the page, you can create a:

a. Viewset
b. Snapshot
C. Backup

d. Carbon copy

Lesson 2 Summary

As a result of this lesson, you can:

o Navigate the InEight Plan Work plans page

e Manage columns
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e Manage data blocks

¢ Create viewsets
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2.5 QUERY BUILDER

The Query builder lets you build queries with multiple conditions to filter the entire table of work
packages. You can add, edit, delete, and share queries with others.

To open the Queries slide-out panel, click the Query icon on the left side of the page.

= 1 / Plan / Work packaging
| Work Packages Actions w @
X Work
Planning Schedul N
T IE Queries

My queries

OO0 o0o0oonDo

Cancel

2.5.1 Add a Query

A guery is made up of conditions that are made up of columns, values, and operators that connect the
columns and operators. Multiple conditions can be grouped as And or Or statements.

The following step by step shows you how to add a query, apply it, and then save it for future use.
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Add a Query

Click the Query icon on the left side of the page to open the Queries slide-out panel.
Click the Add icon. The Query builder opens.
Select a column and operator from the drop-down lists.

Enter a value that you want to filter the column for.

a & 0 bdh =

Optionally, click the Add icon to add more conditions, and then click And or Or to change how
the conditions are grouped.

o

Click Apply to update results immediately.
7. Click Save query.
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LESSON 3 - WORK PACKAGE
MANAGEMENT

Lesson Duration: 60 minutes

Lesson Objectives
After completing this lesson, you will be able to:
e Explain how to manage work packages
o Create a construction work package
e Create an installation work package
e Edit and review work package details

e Import work packages

Lesson Topics

3.1 InEight Plan Workflow - Work Package Management ..................................... 51
3.2 Work Package Management Overview ... .. ... . 51
3.2.1 Whatis Advanced Work Packaging (AWP)? .. L 51
3.2.2 Work Packages ... 52
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3.1 INEIGHT PLAN WORKFLOW - WORK PACKAGE
MANAGEMENT

A A A

Daily Pendil <
'Y na Qty Actual Quantities
Plan o
P 2
rogress Q
- @ Progress =
Work Packaging J 3
ki @ .
k] o
@ i ing - 2
T3 Daily Planning - Web Weekly Timesheet |
al <
3 Web Daily Web Daily Web Daily Timesheet :
2 ) . 2
3 Planning Execution Approval Entry 2
£5 3
mé 5
5 =
a Q""”V\E’fcu-’e Actual Hours Actual &
g via Yweb or via integration Hours via s
Mobile integration <
Can ﬁag &
via We
or Mobile Can Approve
ﬂw;a g\ieb or Payroll
Aobile System
WBS Element A

Components
Mobile Mobile

. _ Daily Daily
Quantity Tracking ASSOCIATE Planning Execution

Claiming
Schemes
@ Actual Quantities

Plan

Mobile
Daily
Approval

%

Progress

Actual Hours via
integration

Daily Planning — Mobile

Daily Pending Qty

3.2 WORK PACKAGE MANAGEMENT OVERVIEW

3.2.1 What is Advanced Work Packaging (AWP)?

Advanced Work Packaging (AWP) is a standardized way to plan the execution of a construction
project including design, procurement, and installation. AWP aims to change the planning process to
be execution driven: approaching the beginning of your construction project with the end in mind. In
the past, planning was siloed, Engineering first, then Procurement, and finally Construction. AWP starts
with the priorities of Construction and or commissioning and works backwards.

The Work Packaging module of InEight Plan provides an organized platform to break down your project
into manageable scopes of work. Work packages can be developed to include all items necessary to
complete the scope as well as all constraints that would impede progress.
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3.2.2 Work Packages

There are three levels of work package definition that can be used in InEight Plan:

e Construction Work Area (CWA)
e Construction Work Package (CWP)
e Installation Work Package (IWP)

Scenario

Imagine you are working on a project with the following scope: 30 modules in which you need to
complete earthwork, foundations, and erect the steel support structures.

North Area
(03 | 05 |07 09| 1113 |15 | 17 | 19| 21 23 | 25 | 27 | 29|

South Area

Using the scenario above as an example, assume that you initially break the project into two
construction work areas (CWA): North Area and South Area. You break each area of work into three
different construction work packages: Earthwork, Foundation, and Steel Erection. From there, you can
break each construction work package into multiple installation work packages so you can plan at a
detailed level and identify the specific constraints, components, safety and quality risks.
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Project Steel Structure project

CWA North Area South Area

Steel . Steel .
CWP ErEsien Foundation Ernction Ees e

WP Steel Erection Steel Erection Steel Erection Steel Erection Steel Erection Steel Erection
Module 01 Module 03 Module 05 Module 02 Module 04 Module 06

TIP Construction work areas (CWAs) are created for the project or organization in the

Configure CWA and project values page prior to defining construction work packages.

3.2.2.1 Construction Work Package (CWP)

A construction work package (CWP) defines a logical and manageable division of work within the
construction scope. CWPs are aligned with the project execution plan (which includes the construction
plan) and the WBS. The division of work is defined such that CWPs do not overlap within a discipline.
CWPs are to be measurable and in alignment with project controls. CWPs are the basis for the
development of detailed installation work packages. They should also align with engineering and
procurement work packages. A typical CWP includes the following:

o Safety requirements

e At least one EWP

e Schedule

e Budget (work hours/cost/productivity)
e Environmental requirements

e Quality requirements

e Special resource requirements

A CWP can also contain activity, material, and contract components.
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A CWP may be divided by area, system, or as otherwise determined by the project (construction)
execution plan. In general, it is better to develop CWPs by discipline. A large project will likely contain
multiple CWPs. CWPs can be the basis of contractual scopes of work. A contractual scope may contain
more than one CWP. Complete specifications of CWPs grow over time to include productivity factors,
detailed cost reports, and other considerations.

3.2.2.2 Installation Work Package (IWP)

An installation work package (IWP) is the deliverable that enables a construction work crew to perform
work in a safe, predictable, measurable, and efficient manner. An IWP is scoped to be manageable and
“progressable”; it is typically of limited size such that a crew can complete the work in about a week.
An IWP contains the necessary documentation supporting workface execution. IWPs should be
approved by the responsible stakeholders, and all constraints should be completed before issuance to
the field. A typical IWP includes the following:

e Work package summary — inclusive of description of work, location, system or facility code,
originator, contact information, sequenced work steps, reference documents, estimate of work
hours and quantities, cost codes, witness or hold points, and special comments quantity work
sheet

o Safety hazard analysis, specific to tasks in work package
e Material Safety Data Sheet

e Drawings (engineering and vendor design)

o Specifications (engineering and vendor design)

e Change documents (i.e., field change request, deficiency report/non-conformance report and
design change notice)

e Manufacturer’s installation instructions model shots
o Bills of Materials
e Required tools
 Installation test results forms
e As-built documentation
¢ Inspection checklists
e Completion verification signatures

All elements necessary to complete the scope of the IWP should be organized and delivered before
work is started. As the originator, you should cover the work with the responsible safety, quality,
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3.3 Work Package Creation

superintendent, and craft personnel in a preparatory meeting, with special focus on anticipated

constraints.

Generally, the scope of work associated with the IWP should be small enough that it could be
completed by a single foreman and crew within a pre-defined block of work hours. Work hour blocks
should be between 500 and 1,000 hours. An IWP contains all applicable and pertinent documents in
support of safe and efficient installation of a specific portion of a system by a given trade. These

documents are written specifically for the crew performing the activity.

3.3 WORK PACKAGE CREATION

The first step in utilizing the Work Packaging module is to set up your work package structure.

3.3.1 Create a Construction Work Package (CWP)

The following steps walk you through creating a construction work package.

Create a Construction Work Package (CWP)

1. From your project's home page, navigate to the Work packaging module.

) Plan

= Control

Assigned users

Operational rate codes

Quantity tracking

Work packaging

T Compliance

Assigned operational resources

Assigned disciplines and commadities

@) 105091 (Steel Training Job) - Projecthome ~
Applications
O] v
Add project image
&/ Document
105091 (Steel Training Job)
) Schedule
Project
Project home
Project details
Report Settings
Report
e Workflows
Explore
Dashboards
APIdocumentai tion
5 contol 5 Contracts
Workspac st
Project ibrary
Plar
Quantity tracking
Work packaging
% Progress
Osily planning
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® O 0 @

%) Quantity tracking

5) Contract § -
ts and forecasts Build components and document quantities
%) Change Launch
& Links
Extensions r your crew Organization
Desian In€ighty
Billing TeStS6TTest567Tests6TestS6Tests67Tes
Jments MahendranMahendranMahendranMahendra.
Karthik
TEST124
154 Project
%) Change status %) Prime contract summary
I Closed [ InPro. Active Actusi vakoes
Issue Original contract 5000
o o 0 Executed Client CO's 5000
Potential clent change orders
Adjusted/Current contract 5000
° 0 o In Review Client CO's 5000
Glient change orders
Projected contract 5000

0 0
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2. Click on the Action menu and select Configure CWA and project values from the drop-down

list.
{ Steel Structure Training Job (105091) Work packaging «
Work Packages Actions ¥ @
| = Conﬂgurne CWA and project values I D |

Planning Schedule

Ir
Work Mge import history

O [ South

O » [ Unassociated packages

3. Click on the Add icon on the left toolbar and select Construction work package - CWP
from the drop-down list.

[} Steel Structure Training Job (105091) - Plan Work packaging
| Work Packages Actions »
Construction work package 5 CWP ipth
Planning Schedule A U “ netallation B == | LR GL
Construction work pa¥iige - CWP
(] " — 2 North
0 [ South South
O » [ Unassociated packages

TIP Construction work packages and installation work packages can also be created
within the construction work areas, for example the North construction work area,
by clicking on the North construction work area folder then select the add button.

4. In the new dialog box, name your CWP. Work package names can be 100 characters in length.

X
Add CWP

CWP name

CWP- Morth Area Steel Erection Work Plan - XXX
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o= Note that the CWP name automatically begins with “CWP-“ by default. You can
erase it.

5. Click Add.

e =0 Your created CWP will be located in the Unassociated packages folder by default
when you create them outside of a construction work area folder.

T Steel Structure Training Job (105091) - Plan « Work packaging
| Work Packages Actions w @
Planning Schedule Y U A e
] [ North
O [ South
O 5 Unassociated packages
O B CWP-North Area s | 11
O 5 IWP-mnn 5
O [E CWP-hkh 4

3.3.2 Edit Work Packages

After creating the work package, you might need to go in and edit the details. This includes:

e Schedule start and finish dates

Planning start and end dates

CWP Description

CWA description and ID

Plan Status

Other fields
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Edit a Work Package

1. From the Work plans/packages page, select the hyperlink ID on your newly created package.

i Steel Structure Training Job (105091) Work packaging ~
Work Packages Actions v @

Planning Schedule O | ¥ Workpackage name I
D » [ North
O [ South
O . [ Unassociated packages
O [E CWP-North Areas.. | 11
O 5 WP-mnn 5
O B CWP-hkh a

o

Select the Construction Work Package Overview tab.
Under CWP description, enter a description.

In Scheduled start date, select a date.

In Scheduled end date, select a later date.

Select an Engineer.

Select a Planner.

© N O O bk Db

Select a Superintendent.

TIP The Engineer, Superintendent, and Planner fields are validated fields and will bring
up a list of people from which to select, once you enter a character.
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‘Work pack: A CWP-North WORK PACKAGES CONSTRUCTION WoRK WORKSPACE OENERAL DOCUMENTS
fork packa. > A > “Horth - PACKAGE OVERVIEW - CONSIDERATIONS

cwPID WP name CWP Lastupdated on CWP Last updated by

CWP-North Area Steel Erection

WP Deseription

Mhe % Complete

Work package fo structural steelof North area

0%

owAID WA deseription Planning start date Planning end date

Cost % Complete.

SchedulelD Schedule Name Scheduled start Scheduled finish

0% = =

Work package summary

wes W8S desciption Quantites vom Hours

2618 Sub Tracking - D1 MV Terms. 2012386 £ach 043

9. Now that you have all the CWP overview details, you can go back to the Work plans/packages
page by selecting Work packaging in the breadcrumbs.

Work packaging | > CWP- North Area Steel Erection...

Work Packages

CWP- North Area Ste...
90982 CWP ID
Work package for the ..

90982

3.3.3 Copy Work Plans

You might need to create the exact same work package for a new area with only a few small changes.
Instead of repeating the entire process of creating a new work package, your best choice would be to
create a work plan from an already existing one, making the few small changes as necessary.

Copy a Work Package

1. On the Work plans/packages page, select your previously created work plan, then select the
Copy icon.
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o Steel Structure Training Job (105091) Work packaging +

Work Packages

D P
Planning Schedule Y O escription
O 4 B North Morth
» [ CWP-NorthAreaS. 9
O [ South South

] » [O Unassociated packages

TIP You can copy as many as ten work packages in the same project at the same time.

e This brings up a new dialog box for you to select what information to carry over
2. Rename the work plan.
3. Uncheck Overview page and Workspace (all data blocks).

4. Click Copy to finish creating your new work plan.

Copy selected work package

Work plan/package name

| CWP- South Area Steel Erection Work Plan - XXX

Include the fellowing

Overview page
orkspace(all data blocks)

3.3.4 Create an Installation Work Package (IWP)

Continuing with the scenario above, you will create an installation work package.
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£

Within each installation work package, you can assign the labor, components, equipment, materials,
and other aspects you need to complete the work.
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Create an Installation Work Package (IWP)

1. From your project's home page, navigate to the Work packaging module.

@) 105091 (Steel Training Job) - Projecthome ~ @ O ® ®

Applications

&
© Model Estimate £% ) Plan (®) Contract

Add project image

% Quantity tracking

ts and forecasts Build components and document quantities

Quantity tracking

&) Document (+) Control &) Change Launch Launch
105091 (teel Training Job) T

<) Schedule T Compliance

Applications _— _— & Links
Model
Project Extensions b your crew Organization
% Document
Schedule Project home Assigned users Design Launch neighty
a
Project details Operational rate codes
Biling TestS6TTestS67TestS6TTestS67TestSGTTes.
Report Settings Assigned operational resources —_—  mems Vishencranvahendrantishendraniahendia.
Reports
P Workflows Assigned disciplines and commodities Karthik
Explore " n TesTI24
Dashboards
- @ Project -
API documentation
5 contol 5 Contracts %) Change status %) Prime contract summary
Workspaces Status. Count M Closed || InPro.. | | Active
Actual values
Project lbrary
ssue originalcontract 5000
Plan
o 0 0 Executed Client CO's 5000
Quantity tracking otential clent change oger
P — Adjusted/Curtent contract 5000
o 0 o In Review Client CO's $0.00
% Progress Client change orders
Daily planning Projected contract 5000
0 0 0
(o)

2. On the Work plans/packages page, select the Add icon and select Installation work
package - IWP.

r Steel Structure Tral Work packaging ~

Work Packages Actions

]y Construction work package - CWP
| Installation work package - IWP |

N

» [ CWP-North Area 5. 9

Planning Schedule Y

O
i

]

[ South

O

» [ Unassociated packages

3. Inthe Add IWP dialog box, name your work package and click Add. Work package names can be
100 characters in length.
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Add IWP

IWP name

IWP- Steel Erection - Module 001

3.3.5 Group Work Packages

After creating work packages, you can group them underneath the plans you have created. This helps
with the organization and planning of the work.

Group a Work Package

1. On the Work plans/packages page, select a work package.

Meyg= Notice that CWPs and IWPs have different icons.

¥ Work package name

~ [ North

2 ICWP- South Area Steel Erection Work Plan - XXX

= ICWP- Morth Area Steel Erection Work Plan - XXX

[0 South
~ [ Unassociated packages

SIWP- Steel Erection - Module 001

2. Click the Move into CWP icon.
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{ Steel Structure Training Job (105091) Work packaging

Work Packages Actions ¥ @ ® E
e V= o

[0 ¥ Workpackage nam

Planning Schedule b ¢
0O . B Norh
O , [E CWP-Morth Areas.. 9
O [ South
O 4+ B Unassociated packages
[ IWP-Steel Erectio.. 12
O B CWP-North Areas. 11

TIP You can also group installation work packages into construction work packages by
clicking anywhere in the row for the installation work package and dragging it over
top of the desired construction work package.

3. Inthe Move into CWP dialog box, start typing the name of your construction work package.

X
Move into CWP

Work plan name

Steel X

CWP- North Area Steel Erection Work Plan - XXX

CWP- South Area Steel Erection Work Plan - XXX

4. Select the CWP you want to move it to, then click Move to move the package to finish grouping
your packages.

TIP You can also group construction work packages into construction work areas by
editing the CWP in the Construction Work Package Overview tab, then selecting the
appropriate CWA ID or CWA Description from the drop-down.
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3.4 DAILY PLAN FROM WORK PACKAGE (DAILY PLAN
WIZARD)

Scenario

Tomorrow, your crew will be starting the steel erection work on your module. You are now ready
to plan the work for your crew. During this first day, you want your crew to install the A7
connections to foundations. Your crew will consist of a Grove-RT880E crane, 3 Ironworkers and 1
Laborer. You want to make sure to communicate the work to your crew and identify safety
concerns for the day.

* AT Coburmn
A Cobumn i = Assembly

Assemibly ."\‘ '

o1y ]

[a..l

)

GROVE -RTESOL

In this topic, you will create a daily plan from an already existing work package using the Daily Plan
Wizard in the InEight Plan web application.

3.4.1 What is a Daily Plan?

After you put your work package together, you break it down into daily segments, or the work you plan
to accomplish in a given day.

InEight Inc. | Release 22.6 Page 65 of 90



3.4 Daily Plan from Work Package (Daily Plan Wizard) Plan User Guide

Using the scenario above as an example, your steel erection work package for your module will take
multiple days to complete. You will use daily planning to plan the work in the sequence you are looking
to do it in, day by day. Daily planning is a good tool to communicate to your crew your safety concerns,
quality and environmental risks, and expected productivity.

Daily planning combines:
e Components
e Activity components
e Material components associated with WBS
e Resources (employees, and equipment)
e Planned hours
e Planned quantities
« Notes/Issues

o Attachments (for example, safety notes, plan specifications)

3.4.2 Daily Plan Wizard

The Daily Plan Wizard is a powerful tool that can help automate the process of setting up daily plans by
copying information from an already existing work package to avoid duplicate work. The Daily Plan
Wizard allows you to choose which parts of the work package will be brought into the daily plan.

You access the Daily Plan Wizard from Plan Work packaging module.

Overview - Daily Plan Wizard

1 Plan Date The date on which the plan will be executed.
2 Plan Name Unique name of the daily plan.
3 Shift A drop-down field where you can select either the Day
or Night Shift.
4 Work Plan/Package ID- This should be auto populated with the name of the
Name work plan/package that the current daily plan is being

created from.

5 Planner Notes A free text field where you can add any relevant notes.
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Overview - Daily Plan Wizard (continued)

6 Location A free text field where you can enter the location where
the work will be performed.

7 Approvers Responsible for the approval of the plan.
(1 required)
8 Executors (1 required) Responsible for the execution of the plan.
9 Navigation Buttons Allows you to either cancel or create the new daily plan.
X
Add daily plan
= Plan date * Plan name
o - @
Shift Work plan/package ID - Name Planner notes

Day Shift v o o

Location

= Approvers (1 Required)

= Executors (1 Required)

© © 00

The following Step by Step walks you through how to use the Daily Plan Wizard.

MeJ =0 This Step by Step assumes you already have a work package (CWP or IWP) created
containing work package details (e.g., labor, equipment, components, safety). See Work
Package Creation for details on setting up work packages.
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Create a Daily Plan Using the Daily Plan Wizard

1. From your project home page, navigate to Plan > Work packaging.

— A DemoProject] 03062021 / Project home

ﬁ' & Links (%) Control () Quantity tracking
Add project image Organization Manage budgets and forecasts Build components and document
Minimum of 540px x 360px quantities
Project Launch Launch
Dema Project | 09062021 a
Quantity forecasting @ %) Work packaging (%) Daily planning
Engineering ) )
— Group work into plans and Assign tasks for your crew
Estimate o] packages

Workspaces
Project library

= Project notes (@) Contracts ) Supporting documents

[EY

Plan

Quantity tracking

Work packaging
(o)

Daly planning

Status Count

£ Settings ) Bid packages
Time center

Weekly ime sheet Project and application settings

Capital Manage settings ® o

2. From the Work Packages tab, open a Construction Work Area (CWA) and click on the arrow in
the ID column of your Construction Work Plan (CWP) to extend the work package below.

3. Select a Construction Work Package (CWP) by clicking on its hyperlink ID.

Work plans
Work Packages
Actions ¥ @
Planning Schedule
¥ Work package name ID Description Schedule ID
A [ Morth North
| ~ |5 CWP- North Area Ste.. 90982 Work package for the struct..
»w [ South South

[ Unassociated packages

4. Open your Installation Work Package (IWP) by clicking on its hyperlink ID.
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Work Packages

CWP- North Area Ste...
90982

Work package for the

0%

3.4 Daily Plan from Work Package (Daily Plan Wizard)

Work packaging  *  MNorth  »  CWP- North Area Steel Erection...
CONSTRUCTION
WORK PACKAGES PACKAGE OVER
(]} Work package name ID Description Schedule ID

O 5 IWP- Steel Erection - Module 0. | 90984 Steel erection of Module 001.

5. From the IWP page, click on the Workspace tab.

Work packaging >

North > CWP- North Area Steel Erection.. > IWP- Steel Erection - Module 0...

Work Packages
OVERVIEW CONSTRAINT MANAGEMENT
IWP- Steel Erection ...
90984
Steel erection of Module D01 Components <o >
Component ID Description Quantity UoM
Manage workspace -
b § Moadule 01 - AG Connection to Fou..  Module 1 - AG Connection to Foundation 1 Ea
B b Madule 07 - AT Gonnection to Fou.  Module 1 - AT Connection ta Foundation 1 Ea
[ Materials
¥ Budget b § 3 Module 03 - A6 Connectionto Fou . Module 3 - A6 Connection to Foundation 1 Ea
[##| Components
[ Lessons learned b § m Madule 03 - A7 Connection to Fou..  Module 3 - A7 Connection to Foundation 1 Ea
[ Quality forms ) . . .
- - E
v b § Moadule 05 - AG Connection to Fou..  Module 5 - AG Connection to Foundation 1 )
[ Tools
(] Temporary structures
[+ Labor
6. Click on the Daily Plan icon.
Work packaging  *  Morth > CWP- Morth Area Steel Erection..  *  IWP- Steel Erection - Module 0..
Work Packages
=N
OVERVIEW
IWP- Steel Erection ..
90984
Steel erection of Module 001. Components
Component ID Description

Manage workspace

|« Equipment
|| Materials
|#| Budget

[#| Components

Module D1 - AG Connection to Fou..  Module 1 - AG Connection to Foundation

Module 01 - A7 Connection to Fou..  Module 1 - AT Connection to Foundation

Module 03 - AG Connection to Fou..  Module 3 - AG Connection to Foundation

=
~E [FE =K

« This opens the Daily Plan Wizard slide-out panel
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7. With the Daily Plan Wizard open, select the components, resources, etc. that you want to copy by
clicking on the calendar icon from your data blocks.

Workpackaging > North > IWP- Steel Erection - Module 0. X

I Work Packages - Create daily plan

Components

IWP- Steel Erection ..
90984

Module 03 - AG Connection to .

Components . 2 Planning complete @® Add components by WBS

Gl e L ) . Module 01 - AT Connection to =
Component ID Description Quantity UoM wes Percent co. Estimated h.  Discipline/Commodity

Module 05 - AG Connection to

/abm

Equipment

Quality

Torque Inspection
Hew quality item 3

Work step num...  Deseription Anachments  Hold point Man hours. Senesule start ‘Scheduie finish

e Offload steel g o230 ou/231200 = safety
L Instal steel - 0312372020 032112020 Wateh for falling objects
b 3 3 Bolt and torque =8 o 03/26/2020 03/27/2020
} S Gualityinspection =
s Tumover g} e ol
© 2020 Icight Inc. Privacyand Terms | 4202 | KS9KF LTy

¢ Your selections are shown in the Wizard

Not all data blocks can be copied. If no calendar icon is shown, that data block is
not available to be populated in daily planning. Activity components can only be
used if they can be claimed in Plan Quantity tracking. Labor and equipment can
only be used if they are active in the project date range.

8. When finished, click Next on the Daily Plan Wizard.
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Quality

Torque Inspection =

=

New guality item 3

Safety

Watch for falling objects

Environmental

INEIGHT

9. Enter your new daily plan details.

Jlelg2 You can complete and edit these daily plan details at any point. Notice that only
some fields are required to create a new daily plan.
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Create daily work plan

o Plan details

= Plan date = Plan name
Shift Work plan/package ID - Name
First shift - 90984 - IWP- Steel Erection - Module

ool

Location

Approvers (1 Required)

Planner notes

Executors (0 Required)

10. Click Next.

Plan User Guide

11. Confirm that all your selected components and resources are correct for your new daily

plan. Then, click Next.
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Create daily work plan

° Confirm resource

i

Component D Description Tatal MHRs

r

@&  Module 03 - A6 Connection to Fou..  Module 3 - AG Connection to Foun.. 0

&  Module 07 - AT Connection to Fou..  Module 1 - A7 Connection to Foun.. 0

Employee ID Name Trade

»

No employee topics added

i

Equipment ID Description Category

No equipment topics added

-

(o ) [(oor )

3.4 Daily Plan from Work Package (Daily Plan Wizard)

12. Verify that everything is correct for the Tool box talks section. Then, click Create plan.

Create daily work plan

°Toolbox talks

i

Safety concern Mitigation

®  Wwatch for falling objects

i J

Quality concern Mitigation
@ Torgue Inspection .
@ MNew quality item 3 -

i

Environmental concern Mitigation

No environment topics added

Create plan

I J "

Skip planmng] [Saveand createanother] [ Cancel I [ Back ]

InEight Inc. | Release 22.6

X

Page 73 of 90



3.5 Installation Work Package Details Plan User Guide

« Once created, you can edit your new daily plan by navigating to Progress > Daily
Planning page > My Daily Plans Tab

3.5 INSTALLATION WORK PACKAGE DETAILS

Installation work packages include the details of a group of activities. The details in the work package
include installation sequence, components, labor, equipment, safety and quality concerns, and other
aspects of the work package. When ready to share, you can attach external files and send to print as a
PDF. Or, if you are integrated with InEight Document, you can easily send packages and documents.

You can also create a daily plan in InEight Progress from a work package. For more information, see
Daily Plan from Work Package.

3.5.1 Work Package Overview Tab

When you open an installation work package from the Work plans page, the Overview tab is like the
construction work package Overview tab, but you can define settings specific to the installation work
package. For example:

e The engineer may be different for this particular package and might report to a different
engineer than assigned at the CWP level

e The IWP’s start and end dates might also be a smaller time period than the CWP’s schedule start
and finish dates

TIP You can also edit IWP fields from the grid view of the parent construction work package.

From the Work packages tab of a construction work package, you can click in fields in the
grid, and then type or select values instead of opening each installation work package to
change values.

Installation Work Package Overview

1. On the Work plans/packages page, select the hyperlink ID of your installation work package.

2. In the Overview tab of your installation work package, enter a description in the Description
field.
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From the drop-down list in the Discipline field, select a discipline.
For Type of work, input short description.

From the drop-down list in the Risk field, select a risk level.
Select a Start and End date.

Select a Planner.

Select a Superintendent.

Select an Engineer.

© © x® N o g kv

Select an Executor.

Workpackaging > North > CWP-North Area Steel Erection > IWP-Steel Erection - Module 001

OVERVIEW WORKSPACE CONSTRAINT MANAGEMENT DOCUMENTS

Overview

jon of Module 001

WP 1D IWP name cwp cwA

\WP-Steel Erection - Module 001 o] CWP-North Area Steel Erection v North-North

0%

Cost % Complete Scope of work

0%

Location Discipline Type of work Risk

Metals v| |Sxee\Erecmn | |Mem”m '|

Schedule ID Schedule name Scheduled start date Scheduled end date

I Mon, 3 Aug 2020 B ] |;wmgmn q

Status Last updated by Last updated on

3.5.2 Installation Work Package Workspace Tab

The Workspace tab is where the majority of your planning is accomplished. Here you can enter the
planned labor, materials, equipment, components, among other aspects of the plan. You enter these
details using data blocks. Some data blocks are open entry fields, such as safety, environmental, and
work sequence. However, other data blocks use validated fields based off previously entered
information. These include Budget, Component, and Equipment data blocks.

e g=0 The Labor data block is an open entry field, unless you enter an actual labor resource.

TIP You can track materials assigned as constraints in work packages by integrating with
Intelliwave. See Enable external material tracking integrations for more information.
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Installation Work Package Workspace

1. On the Work Packages tab of the Work plans/packages page, select the hyperlink ID of your
installation work package.

2. From the Installation work package page, select the Workspace tab.

Work packaging > North > CWP- North Area Steel Erection.. >  IWP- Steel Erection - Module 0...

OVERVIEW WORKSPACE CONSTRAINT MANAGEMENT DOCUMENTS

3. Select the View menu and change your view to your previously created viewset (see General

Navigation).
View: | work Packaging v
(¥) Add equipment (¥) Add equipment from resources E
Permit expires Quantity

4. In the Work sequence data block, add work sequence steps by clicking on the Resource button
and enter details for your project.

OVERVIEW WORKSPACE CONSTRAINT MANAGEMENT DOCUMENTS View:  Work Packaging -

Work step number escription Attachments  Hold point Man hours Schedule start Schedule finish

install steel

Quality inspection

H R R R R
®®®®

1
: \
3 Bolt and torque ‘
‘ \
: \
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Jlelg= Create a hold point by clicking in the Hold Point field and select Yes.

Work sequence

Work step number Description Attachments Hold point

1 Off load steep |T_ﬂ

2 Install steel F_ﬂ

3 Bolt and torque None - ‘
4 Quality inspection F_ﬂ None

5 Turnover =0 No

| Yes |

5. In the Labor data block, add labor by clicking Add labor from resources and enter details for
your project.

M Planning complete @ Addlabor | @) Add labor from resources

Trade Craftlevel Code Description Quantity Employee ID Name

6. Inthe new dialog box's Project Resources tab, search for employee names and click the Add icon
and enter details for your project.

Add labor from project resources

PROJECT RESOURCES  ESTIMATE/CONTROL RESOURCES

Available employees in project
Employee ID Name Trade Craftlevel

00020111 Jack Spooner Pipe Workers Pipefitter Journeyman

TIP You can search based off any of the fields associated to the employee (e.g.,
Employee ID, Trade).

J{e =0 You can add multiple employees at a time in this dialog box. Only employees who
can be added to daily plans will show up in the drop-down selection — See your

Account Administrator if you do not see an employee.
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o= You can also add generic labor from assigned WBSs in the Estimate/Control
Resources tab. You must first add a component associated with the appropriate

WBS to the IWP.

7. In the Equipment data block, add equipment by selecting Add equipment from resources and
enter details for your project.

@ Add equipment | () Add equipment from resources

Equipment ID. Code | Descri pion = Cate gory EquipmentType ~ — Ownershi p  — Pemitey pires. Quantity

Me3ga You can also add generic equipment from assigned WBSs in the Estimate/Control
Resources tab. You must first add a component associated with the appropriate

WBS to the IWP.

8. In the Activity Components data block, add equipment by clicking Add Activity components by
WABS and then entering details for your project.

e I= A component can only be present in one package at a time. It cannot be in both the

- CWP and its child IWP due to percent complete tracking purposes.

Meyp=n If the work package is assigned to a work area, the activity component's location is
updated to the work area in Quantity tracking and can no longer be changed in that
module.

9. In the Safety data block, add steps by clicking Add safety step and enter details for your

project.
Safety $oe > (®) Add safety step H
Step Description Safety risk ‘ Mitigation Required safety items

1 Crush Points ‘ @
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10. On the Breadcrumbs bar, select Work packaging to go back to the Work plans/packages page
and view your completed work plan and work package.
3.5.3 Installation Work Package Constraint Management Tab

In the Constraint Management tab, you can review items pinned in the Workspace tab or manually add
new constraints. For more information, see Constraint Management.

3.5.4 Installation Work Package Documents Tab
Add, edit, and share IWP documents from the Documents tab. As documents are updated, get the
latest information by looking for the revision number, modifier, and date of modification.

You can add attachments to the Lesson learned, Quality forms, Temporary structures, and Work
sequence data blocks from the Workspace tab. These additions show in the Documents tab.

3.6 WORK PACKAGE IMPORT AND EXPORT

3.6.1 Import Template

Creating and copying work packages can be time consuming. You can use an Excel import template to
upload multiple work packages with their overview information already populated.

Create Work Packages from Excel Import

1. On the Work plans/packages page, click on the Export icon, and select to export With Data and
open the export file.

InEight Inc. | Release 22.6 Page 79 of 90



3.6 Work Package Import and Export

Created by

TIP

Last u; With data
/wwnhout data

11/12/2019

Q

Plan User Guide

Excel templates without data are used for creating new components from scratch,
usually during project setup.

Excel templates with data are typically used to update existing work

plans/packages.

2. Open the export file.

e This opens up the Excel template to use for the import. It also contains the data from the
current work packages on the Work plans page

e You may need to select Enable editing at the top of the spreadsheet prior to entering data

A B

3 3

1 [Engisn User Selected Language

2 REQUIRED o

3 [OPTIONAL

4 [VALIDATED

5 IGNORED

6 [Name Jio Jewe o [schedule iD | |
7 [Numes [Numeric [Alphanumeric Igme MM/DD/YYYY. 1
s 50 200 100 20 m 1
9. [IWP- Steel Erection - Module 001 35738 35732

10 |CWP- South Area Steel Work plan ural steel of the North 35723 1/a/2019

11|CWP- North Area Steel Work plan ural steel of the North 35722

11/a/2019

3. Input information into your template to be uploaded. At the bottom of the list, add information
for the following categories:

e Name

e Package Type

e Description

o Assign the proper CWP to your work package in the CWP ID field

English User Selected Language

REQUIRED Field is required for import

OPTIONAL Field is optional for import

VALIDATED Field must match master data available in application

IGNORED Field not to be populated

Name Package Type Joescrij tion Jio Jewe iD |
[CWR/IWR/EWP | |Numeric Numeric |

50 3 J1o00 J200 100 |

1wP- Steel Erection - Module 001 we Steel erection of Module 001 35734 35732

CWP- South Area Steel Work plan cwe Work Package for the structural steel of the North 35732

CWP- North Area Steel Work plan CWP

Work Package for the structural steel of the North

[wp- steel erection Upper Deck - Module 001 1wp

Upper rack steel erection

35723

4. Delete all the work packages that came with the template.
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|English User Selected Language

REQUIRED Field is required for import

| OPTIONAL Field is optional for import

VALIDATED Field must match master data available in application

IGNORED Field not to be populated

Name Package Type |De5crimn

A CWB/IWB/I | Calibri ~ |11 ~|A° A" $ ~ 9, 9 numeric

0 2 BISZSO-AT-RYS

IWP- Steel Erection - Module 001 Iwp B srection of Module 001

CWP- South Area Steel Work plan CWP Work Package for the structural steel of the North
CWP- North Area Steel Work plan CWP & Cut ‘Work Package for the structural steel of the North
IWP- Steel Erection Upper Deck - Module 001 WP [ Copy Upper rack steel erection

[y Paste Options:
Paste Special...

Insert

Clear Contents

e} g= When you import a template to Work packing with a blank value in a field, the
previous value is not deleted. If want to delete a value when importing, you must

type null in the field.

5. Save this Excel file to your desktop.

6. InInEight Plan, on the Work plans/packaging page, click the Import icon.

B Q

Created by Last updated on

11/12/2019
bridgette quintero 11/13/2019
bridgette quintero 11/14/2019

11/12/2019

e An Import data from template window appears

7. Click Browse to find your saved template.
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Plan - Google Chrome

Import data from template

The data will be imported into work plans

Drag and drop the file here or browse

1
'
1
'
! Browse
1
1

Email me upen cempletion

8. Click Import.
e The import file is added to the import queue

e To see all your import files and their statuses, click View file import queue

J[eJ =0 You can continue working in the application while your imports are
processed. A notification tells you if your file is imported successfully or not.

TIP If you have an error, check that the name of your work package is not the
same as an existing work package.

9. Click Close.

Import data from template

File successfully added to import queue

You will be aleried once the file has completed the import process.

@ view file import queue
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3.6.2 Export to Another Project

The following Step by Step shows you how to export some or all of a work package to another project.

3.6 Step by Step 1 — Export Work Package to Another Project

1. Select a work package.

2. Click the Export icon, and then select To other project from the drop-down list.
« The Export work packages dialog box opens

3. Select a destination project, and then click Next.

e = You must have permission to create work packages in the destination project to
export to that project.

4. Select the pages and individual data blocks you want to export.

o) g= The Documents page is shown in the dialog box but cannot be selected to copy.

(le = You can only export data that is entered as free text. You cannot export project-
specific data such as components.

5. Click Export.

3.6.3 Import from Another Project

The following Step by Step shows you how to import some or all of a work package from another

project.

3.6 Step by Step 2 — Import Work Package from Another Project

1. Select a work package.

e = You must have permission to create work packages in the destination project to
import into that project.

2. Click the Import icon, and then select From other project from the drop-down list.
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« The Import work packages dialog box shows
3. Select an origin project, and then click Next.

4. Select origin work packages, and then click Next.

ey g= You can import from multiple work packages at the same time.

5. Select the pages and individual data blocks you want to import.

e = The Documents page is shown in the dialog box but cannot be selected to copy.

ey g= You can only import data that is entered as free text. You cannot import project-

specific data such as components.

6. Click Import.

3.7 CONSTRAINT MANAGEMENT

This topic describes the Constraint Management tab of an installation work package (IWP).

3.7.1 Summary

You can define constraints on a work package's completion in several ways and manage all of them on
the Constraint Management tab. Constraints can be added manually or by pinning items from the IWP
Workspace tab.

Workp.. > IWP-d. & Print Report

OVERVIEW WORKSPACE CONSTRAINT MANAGEMENT DOCUMENTS

® [ Planning complete

O item number Name /1D Description Gategory Responsibility Due date Expected date: Notes Status

Constraints are organized into categories, most of which correspond to the data blocks of the
Workspace tab:

« Equipment
« Materials
« Budget

« Components (activities)
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« Lessons Learned

» Quality Forms

« Work Sequence

« Tools

« Temporary Structures
« Labor

« Quality

o Safety

« Environmental

« Contract Components
« Work packages

Each constraint can be assigned to a responsible party and given due dates, expected dates, and notes.
Constraints have a status of either Open or Closed and can be changed to show whether they are
resolved or not.

3.7.2 Considerations

e Some constraints, such as work packages, can have their status automatically updated. When a
work package tagged as a constraint has a status of Construction complete, its related
constraint's status changes to Closed.

e You can track materials assigned as constraints in work packages by integrating with Intelliwave.
See Enable external material tracking integrations for more information.

 If you pin a material component as a constraint, associated notes on the Constraint management
tab can contain notes sent from Intelliwave.

e Each note is limited to 500 characters and does not support any special formatting.

3.7.3 Add a constraint

You can add constraints manually in the Constraint Management tab or by pinning them in the
Workspace tab.
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3.7 Step by Step 1 — Manually add a constraint

1. Openan IWP.
2. Click Constraint Management at the top of the page.

3. Click the Add icon in the upper left of the table. A new constraint is added with the Item number
column automatically filled in.

4. Click in the blank field under the Category column, and then select a category from the drop-
down list.

5. Type a name under the Name / ID column.

Mexaga If you select Work package as the category, the Name / ID field searches for work
packages with matching names or IDs in your project.

6. Enter additional information in the remaining fields, as necessary.

3.7 Step by Step 2 — Pin a constraint from Workspace

1.
2.
3.
4.

Open an IWP.
Click Workspace at the top of the page.
Select the check box next to the data block that you want to open.

Click the Send as Constraint icon on the left side of the data block for the record you want to pin
as a constraint. The record is added to Constraint Management as a constraint.

I o] overview pr—— CONSTRAMT MANAGEMENT vocuEnTs View  Gument viewset
1WP-ddddd
P

Marage workspace

B Euipment
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5. Open the Constraint Management tab, and then fill out additional fields for the new constraint,
as necessary.
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Exercise 3.1 — Enter Work Package Details

Now that you have learned to create work packages and fill out all details, create your own
construction work package (CWP) and installation work package (IWP) using the method you prefer.
Make sure to fill out all details for your installation work package.

1. Include at least one safety item.
2. Include at least two components.
3. Include at least two labor resources.

4. Include at least two pieces of equipment.

Congratulations, you have completed this exercise!
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Lesson 3 Review

1. This type of work package allows you to manage a smaller, more detailed scope of work
that is “progressable”.

a. Installation work package
b. Construction work package
C. Advanced work package

d. Discipline work package

2. You can group under to organize your work.

a. CWPs, IWPs
b. IWPs, CWPs

C. work plans, work packages

3. On the Workspace tab, what data blocks contain open entry fields? (Select all that apply)
a. Labor
b. Equipment

Safety

Budget

Component

-~ ©® a2 o

Work sequence

g. Environmental

4. Utilizing the import template, you can upload which of the following?
a. Construction work packages
b. Installation work packages
C. a&b
d

. None of the above

InEight Inc. | Release 22.6 Page 89 of 90



Lesson 3 Summary Plan User Guide

Lesson 3 Summary

As a result of this lesson, you can:
e Explain how to manage work packages
e Create a construction work package
e Create an installation work package
e Edit and review work package details

e Import work packages
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